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1 What is MiniLog-Comm ? 

MiniLog-Comm is a WINDOWS program to operate the phytron stepper motor controllers 
OMC, TMC, MCC-1, MCC-2, MCC-2-LIN and IXEα by means of PC. Even without 
programming experience you can easily handle the communication with phytron controller 
systems after only a short learning period. 

You only have to connect the phytron controller to the interface connector of your PC, and 
you have to install the MiniLog-Comm software according to the instructions in this  
manual - that's all.  

MiniLog-Comm supports the edition of MINILOG-programs for the phytron controllers 
OMC, TMC, MCC, MCC-2, MCC-2-LIN and IXEα. In addition, MiniLog-Comm handles and 
stores MINILOG-programs, parameter and register sets of the controllers. 

 

 

The Main Features of MiniLog-Comm on One View 
• Desktop with pull-down menus and mouse support  

• Hotkeys for frequently used instructions 

• Menu dialog in 2 languages (German and English) 

• Dynamic allocation of PC resources, that means, MiniLog-Comm will only occupy the 
memory space needed in each moment.  

• Program editor for an unlimited number of program lines  

• Register editor for 1000 numbers of register 

• Parameter editor for up to 8 stepper motor axes 

• You can edit and store up to 7 comment lines of unlimited length to each MINILOG 
program line and each MINILOG register. The comment lines can be moved 
individually. 

• Operating facility in program test mode: Single step mode, program operating with 
break point setting and error acknowledge message 

• Simple and fast parameter settings of the stepper motor controllers 

• Several programs can be transmitted in single mode by MiniLog-Comm to the 
controller or from the controller to MiniLog-Comm. 

• OMC and TMC controllers are programmable in stand-alone, master-slave or bus 
mode. 

• MCC controllers can be programmed in stand-alone mode or bus mode. 
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2 System Requirements 

MiniLog-Comm can be used on PCs with the following minimum features: 

• Pentium 100 MHz 

• Operating system Windows   2000, XP, Vista or 7 

• 32 MB RAM free memory minimum 

• Windows Explorer 5 

• Mouse 

• CD-ROM drive, if program is installed from CD 

• The following interfaces are necessary for controller connection: 

OMC/TMC and IXEα RS 232 

MCC-1/MCC-2/MCC-2-LIN RS 232, RS 422 / RS 485 (4-wire), 
USB or Ethernet 

 

 

3 Program Installation 

The following folders are saved on the CD: 

English Includes the files for a setup in English 

German Includes the files for a setup in German  
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3.1 How to Install the Program 

1. Put the program CD into the CD-ROM drive. 

2. If the autostart program doesn’t start automatically, open the phytron installation 
program [CD-ROM-address]\Autostart.exe by mouse click. 

3. Phytron’s installation program opens the following menu: 

 

     Start the MiniLog-Comm installation program by mouse click through the 
     autostart program.  

4. The installation program copies the files into the RAM after program start. 

5. The screen shows the following information: 

 

Fig. 1: Setup program for MiniLog-Comm 
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6. Please click on  and the following information is on screen: 

 

Fig. 2: Setup start for MiniLog-Comm 

7. c:\Programs\ Phytron GmbH\Minilog-Comm is the standard directory of  
MiniLog-Comm. Another directory can be selected with . Click on   
to start the installation. 

8. The files will be stored into the defined directory, some files will be stored into the 
Windows directory. 

9. When the message MiniLog-Comm successfully finished is on desktop, the 
installation has been successfully finished. Finish by . 

10. Remove the CD from the CD-ROM drive. 

11. Select Programs −> Phytron GmbH −> 
Minilog-Comm for starting MiniLog–Comm. 

 

 

Remark:  
If you have got the MiniLog-Comm files on another way (e. g. E-mail), the 
program installation can be done like in chapter 3.1 (beginning at item 2). Instead 
of CD-ROM drive select the corresponding directory, on which the file 
SETUP.exe is stored. 
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3.2 File Names 

After installation the following files are stored in the directory: 

Minilog-Comm.exe Program MiniLog-Comm 

MinilogComm-Help.chm Help file 

Folder Parameter 
 

For MCC: 
D_MCC.par : Parameter file in German 
E_MCC.par : Parameter file in English 

For OMC and TMC: 
D_OMC.par : Parameter file in German 
E_OMC.par : Parameter file in English 

For IXEα: 
D_Alpha.par : Parameter file in German 
E_Alpha.par : Parameter file in English 

 

 

3.3 Update of MiniLog-Comm 

If you want to install an update of a MiniLog-Comm copy, the installation program 
automatically deletes the old version before installing the new.  

 

 

3.4 USB Driver 

When the MCC is connected to the PC by USB-interface, the USB drivers of the phytron-
CD have to be installed on the PC (see MiniLog manual). 
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4 The Working Environment Used by MiniLog-Comm  

After the successful program start of MiniLog-Comm the desktop will show up 
like in Fig. 3:  

 

Fig. 3: Desktop after program start 

 

The working environment of MiniLog-Comm consists of several main components: 

1. The selection menu in the top line on the desktop: 
File, View, Transmission, Controller, Options, Help 

2. Toolbars: Selection of some instructions and device address (0 to 9 and A to F) with  
icons (see table) 

3. The working area 

4. The status bar line at the bottom of the desktop:  Interface parameters (COM port, 
baud rate) and controller type  
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Icon Signification Which bar 

 Write new program Toolbar 

 Write new register Toolbar 

 Write new parameters Toolbar 

 Write new Motion Creator Toolbar 

 Send program Communication bar 

 Receive program Communication bar 

 Send register Communication bar 

 Receive register Communication bar 

 Send parameter Communication bar 

 Receive parameter Communication bar 

 Open program file Toolbar 

 Save file Toolbar 

 Print file Toolbar 

 Cut  Toolbar 

 Copy Toolbar 

 Insert Toolbar 

 Search Toolbar 

 Open Help menu Toolbar 

 Undo the last instruction Toolbar 

 Redo the last instruction Toolbar 

 Dialog Open Direct mode Communication bar 

 Dialog Open Operation Communication bar 

 Dialog Open IO-Monitor Communication bar 

 Dialog Open Status monitor Communication bar 

 Show current x-y position Communication bar 

 Start Single step mode of controller program Communication bar 

 Start controller program Communication bar 

 Interrupt controller program Communication bar 

 Stop controller program  Communication bar 

 Query of variables during program sequence Communication bar 

 Controller Reset Communication bar 
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 Search controller Communication bar 

 Choose an object (line, segment) Special toolbar 

 Zoom the desktop Special toolbar 

 Move the desktop Special toolbar 

 
Draw a line from the last data point to the 
mouse cursor. 

Special toolbar 

 
Draw a 90° segment clockwise,  
which can be parameterized afterwards. 

Special toolbar 

 
Draw a 90° segment counterclockwise,  
which can be parameterized afterwards. 

Special toolbar 

 Insert a line in a present object. Special toolbar 

 
Insert a curve (90° segment) clockwise, 
which can be parameterized.  

Special toolbar 

 
Insert a curve (90° segment) 
counterclockwise, which can be 
parameterized. 

Special toolbar 

 

 

 

 

 

i 
You`ll find the MiniLog instructions in the MINILOG manual! 
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5 The MiniLog-Comm Menus 

In this chapter you will find all you need to start and to leave MiniLog-Comm as well as a 
detailed description of each menu instruction, dialog box, switch etc. 

 

5.1 Start and Exit MiniLog-Comm 

Select Start / Programs / Phytron GmbH / Minilog-Comm to start the program by click 
on the left mouse button.  

Use the menu instruction  File / Exit  to leave MiniLog-Comm. MiniLog-Comm displays a 
warning message if there are unsaved data. 

 

5.2 The File Menu 

In the File menu you will find instructions to open files, to create new files, to save 
changed files, to print files and to exit MiniLog-Comm. 

 
 
5.2.1 New 

File / New submenu selects the editor type, if you want to create a new window on the 
desktop. 

MiniLog-Comm fixes the names: program editor ‘Programxx.apr’, parameter editor 
Parameterxx.apa or register editor ‘Registerxx.are’ (xx stands for a number from 1 to 99). 
The files *.apr, *apa and *are are only temporary. The program asks you for a new file 
name in order to save the data.  
We don’t recommend using ‚Program’, ‚Parameter’ or ‚Register’ as a definitive file name. 
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Program Editor  
The program editor opens and creates programs for the controller (*.apr). 
A new program can be created via the icon  or the menu File / New / Program. 

The editor in table form has three columns: 

Line number Program code Comment 

Insert the text in the appropriate cell, an already existing text will be overritten. 

Shortcut Meaning 

[ENTER] or left mouse button Edit the marked cell (edit mode) 

[ENTER] in the last program line Add a new line 

[ESC] in the edit mode Cancel the input  

[STRG]+[ENTER]+marked line Insert a new line above the marked one 

[STRG]+[Y] Delete the marked line 

[TAB] or 

[STRG]+arrow keys or 
click to another cell 

Jump into the next or the selected column 

Comment column: 
It´s possible to enter several lines in the comment column.  
The size of the cell is automatically adapted to the text content. 

Shortcut Meaning 

[ENTER] Jump into the next line of the input field 

[TAB] or 

[STRG]+arrow keys or 
click to another cell 

Leave the comment line 

[STRG]+[ENTER] Move the comment one line downwards  
Remark: 
No program lines are added. 
If a comment is in the last line it will be deleted! 

[STRG]+[Y] Delete the comment (has no influence to the 
program) 



Manual MiniLog-Comm 
 

 
MA 1237-A007 GB 16   

Parameter Editor 
The program editor opens and creates programs for the controller. 
A new program can be created via the icon  or the menu File / New / Parameter. 

If you create a new parameter editor window, the parameters for one axis are 
automatically set using the default parameter file. These values can easily be changed.  
A new parameter editor for another axis is created with Edit / Add Parameterset or the 
“right mouse button” in the context menu. The parameter editor can include parameter sets 
for maximum 8 axes. 
Edit / Remove Parameterset or the “right mouse button” in the context menu deletes the 
parameter set.  
The first parameter set (axis 1) can´t be deleted, because minimum one axis must exist. 

 

 

 

Register-Editor 
The register editor shows the registers of a controller or an open file. 
It is started by the icon  or via menu File / New / Register. The functionality is similar to 
the program editor. 

Also lines can be inserted or deleted by the shortcuts. Unlike to the program editor only 
one comment line can be inserted. 

Important: The editor can create a random number of registers, but the controllers have 
limited numbers. All registers above the numbers of the controller register are not 
transmitted. 
You´ll find the exact number of your controller registers in the controller´s manual. 
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Motion Creator 
The submenu File / New / Motion Creator is used to create two-dimensional movement 
diagrams by drawing lines or circles without any programming effort. 

 

 

Fig. 4: Motion Creator 

The green square shows the present position of the axis. In the example above the 
counter of the x and the y axis is zero. This is the bench mark of the first drawing function. 
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Function of the buttons: 

 

 

The X axis is divided into grid points with the specified value.  
The divisor for the Y axis is calculated automatically by ½ X.  
E. g.: if the divisor X=1000, the graticule of the Y axis is 500  
(see also Fig. 4).   

 
The changes entered at divisor X are accepted and shown. 

 
X and Y zero lines are centered for the view. 

 

The MiniLog code is generated from the graphic. An editor opens, 
where the code can be edited, stored and transmitted to a 
controller. 

 
The total graphics are deleted! 

 
The window is closed.  
If the graphics have been changed, you are asked for saving. 

 

The functions of the Motion Creator are executed in the Draw menu. (See chap. 5.5) 
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5.2.2 Open 

File / Open  submenu opens a dialog box to select a file. First, you are asked to select the 
file type: 

 *.apr Program files Program files on the data medium 

*.apa Parameter files Parameter files on the data medium 

*.are Register files Register files on the data medium 

*.mcf Motion Creator files Motion Creator files on the data medium 

*.* All files   All files on the data medium 

MiniLog-Comm automatically selects the right editor (program, parameter or register) 
during file loading.  

 
 
5.2.3 Save 

File / Save stores the data from the active editor window into a file. 

 
 
5.2.4 Save as 

File / Save as defines a new file name for the data that is edited in the current editor 
window, or stores the data with the same file name but into another directory or drive. 

 
 
5.2.5 Close 

The file in the active editor is closed with File / Close. If files aren’t saved you will be 
asked to save them. MiniLog-Comm remains open.   

 
 
5.2.6 Print 

File / Print  opens the specific Windows print submenu where the printer type and the print 
properties are selected.  

 
 
5.2.7 Side View  

File / Side View shows the print preview. 
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5.2.8 Print Installation 

File / Print Installation enables you to set the different print parameters (e.g. panel-/ 
landscape format…). 

 
 
5.2.9 Exit  

File / Exit:  MiniLog-Comm is finished. If there are still unsaved files,  
you will be asked to save them by MiniLog-Comm. 

 
 
5.3 The Edit Menu 

The Edit menu is a program editor to change the open file. The edit functions depend on 
the file type: 

Program and register files Cut, delete, copy or insert and cancel 

Parameter files Add and delete parameter set. 

 

The Search menu starts from the top of the text and searches for the input text in program 
or comment lines. The corresponding word is marked in bold highlighted after a successful 
search.  

If you click on  again, the search of the input text is repeated throughout the 

program or comment lines. Click on   to replace the text. 

Important: 

You can insert program lines in the program editor by pressing STRG [ENTER].  To insert 
comment lines (up to 7) press [ENTER]. Quit these lines by pressing TAB. 
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5.4 The View Menu 

In View  menu the display of the bars is defined. 
The displayed bars are marked by  . 

 

Toolbar 
 

Statusbar  

Addressbar  

Communication bar 
 

Special Toolbar  
 

The View / Font submenu is only displayed, if the program files are open. Program text 
can be defined by font, face and size. 

 

 

5.5 The Draw Menu 

The Motion Creator has the following functions in the Draw menu:  

Icon Function Meaning 

 Selection Choose an object (line, segment). 

 Zoom Zoom the desktop. 

 Move Move the desktop. 

 
Draw line Draw a line from the last data point to the mouse 

cursor. 

 
Draw CW curve Draw a 90° segment clockwise,  

which can be parameterized afterwards.  

 
Draw CCW curve Draw a 90° segment counterclockwise,  

which can be parameterized afterwards. 

 Insert line Insert a line in a present object. 

 
Insert CW curve Insert a curve (90° segment) clockwise, which can be 

parameterized. 

 
Insert CCW curve Insert a curve (90° segment) counterclockwise, which 

can be parameterized. 
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5.5.1 Drawing and Manipulating Objects 

Select the suitable object via special toolbar for object drawing. Different functions are 
available dependent of the controller (see controller manual). 

The beginning of a curve/line is marked by a green, the end by a red cross. This indicates 
the driving direction (from green to red), in which the curve/line is traced by the controller. 

 

All circular motions have the following definition: 

  

Fig. 5: clockwise (CW) Fig. 6: counterclockwise (CCW) 

 
 
 

 This function marks the object by clicking the object (line or circle).  
Different functions are available: 
-  move an object, 
-  insert new objects at the starting and final point, 
-  parametrize the object with a double click on the object and  
   start the parameter dialog. Different dialogs are opened dependent on the 
   object (line or circle). 

 You can draw a line from the final point of the last object up to the mouse 
cursor by clicking the left mouse button. Releasing the mouse button creates 
the object. Holding the mouse button can move the final point of the line to a 
determined position. 

 This button creates a 90° segment which is driven clockwise.  
The radius of the segment has the default value of the Y scale.  
The starting point of the circle depends on the previous object. 

 A 90° segment counterclockwise is created, see above. 
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 A line at the starting or final point of a circle or split up a line is inserted. 
Procedure: 
Mark the object to be inserted.  
Insert a line to a circle:  click on the start or end of the marked circle.  
Split up a line: mark the line and click to the point, where the new line starts. 
The old line is splitted up and the red marker can be moved by the mouse. 

 

 

Insert a 90° segment by selecting one of these buttons. 

Procedure: 

Mark the object, where the circle should be added. A click on  or  and 
on the start or limit mark of the object inserts a 90° segment. 

Delete 
single 
objects 

Mark the object.  
The button [Remove] deletes the selected object. 
The starting point of the followed object is the final point of the previous object. 
The selected object is deleted from the internal object table of the program. 

 

 

5.5.2 Parameter Line 

Double click to a line opens this dialog:  

 

Fig. 7: The X and Y parameters of a line 

You can enter the X and Y parameters of a line – start and end position – by hand for 
accurate positioning. 
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5.5.3 Parameter Circle 

This dialog is used to position all circle parameters like radius, sector, starting point and 
center.  
If a circle object is inserted, only a 90° segment with defined start, center and end point 
is created.  

 

Fig. 8: Setting of all circle parameters 

Shift the circle by: 

- Click on the middle marker. Notice that all previous and followed circles are moved, 
which are directly cohered.  

- Insert a new center point. 

Also you can specify the sector, the radius and the starting point. 

 

 

5.5.4 Desktop Functions 

 The zoom function changes the scale and the position of the desktop.  
The range of the desktop can be increased by click and drag. 

A larger scale can be specified in the text field divisor. 
The Center View button centers the zero line of the drawing area. 

 Move the desktop by mouse click and drag. This is useful, if the drawing 
figure is too large for the desktop. 
The Center View button centers the zero line. 
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5.5.5 Example 

 

Fig. 9: A figure ´drawn´ by the Motion Creator (way) 

The marked segment shows the three marking points of a circle: start, 
end and center  

 

Fig. 10: Retraced figure in the Show Position (way) 

 

Fig. 11: The generated MiniLog code 
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5.6 The Transmission Menu 

In Transmission menu you will find all functions to communicate with a phytron stepper 
motor controller connected to your PC:  

• Read out or send parameters, programs and registers 

• Delete programs in the controller 

• Send instructions directly to the controller 

• Drive connected motors 

• Test the PC's interface and 

• Monitor controller’s status 

Remark: 
Every instruction in this menu can cause a timeout error. In this case, the instruction is 
cancelled by an error message.  
Please refer to chapter 6 to debug. 

 

 

5.6.1 Send 

Transmission / Send opens a submenu with the items Program, Parameters, Registers 
and Megacard. Megacard is an additional memory of the controller IXEα. 

 

Send program  

Transmission / Send / Program transfers complete programs to the connected controller. 
If a program editor is open, this program will be selected. If no editor is open or no 
program editor is in the foreground, a dialog box is displayed with the existing programs. 

MiniLog-Comm asks for the program you want to send and gives a selection list of all 
stored programs. Select the program by double click on the left mouse button. You will be 
asked if the program does already exist and you want to overwrite it. If you press ‘yes’, all 
programs on the controller are overwritten. This instruction can´t be canceled.  

 
Important for controller MCC: 
MiniLog-Comm receives all programs and deletes the whole controller memory. After that, 
the programs still required, are remitted to the MCC.  
Please avoid to power off the controller or to disconnect the cable during transmission. 
Danger of data loss! 
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Send parameter  
Transmission / Send / Parameter overwrites the parameters of the connected controller. 
The selected parameter files in the parameter editor are transmitted.   

 

Send register  
Transmission / Send / Register overwrites the registers of the connected controller. The 
selected register files in the register editor are transmitted.   

During transmission a progress bar will inform you about the actual transmission status. 

After a successful data transmission, the desktop shows the message  

All Programs/Parameters/Registers successfully received, which is confirmed by OK . 

 

Send Megacard 

Transmission / Send / Megacard transfers programs, parameters und registers to the 
additional memory ‚Megacard‘ of IXEα.  

Please avoid to power off the controller or to disconnect the cable during transmission. 
Danger of data loss! 

  

 

Fig. 12: Menu item ‘Send Megacard Program’  
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5.6.2 Receive 

Transmission / Receive opens a submenu with the items Program, Parameters, 
Registers and Megacard. 

 

Transmission / Program  
MiniLog-Comm asks you, which program you want to read. Select a program of the 
controller programs list by click on the left mouse button. The selected programs are 
received then and displayed in MiniLog-Comm.  
Please note that the programs aren’t saved at that moment. MiniLog-Comm will ask to 
save them.  

 

Transmission / Parameter  
Transmission / Receive / Parameter reads the parameter set out of the controller. Like in 
Transmission / Program: the parameters are displayed in the editor and can be saved 
afterwards. 

 

Transmission / Register  
Like in Transmission / Receive / Parameter: the received register set are displayed in the 
editor and can be saved afterwards. 

 

Transmission / Megacard reads the programs, parameter set and register set out of the 
IXEα's ‚Megacard‘.  

 

A successful transmission of data is messaged on screen, which is acknowledged by 
OK . 

  

Fig. 13: Menu item ‘Receive Megacard Program’ 
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5.6.3 Delete 

Transmission / Delete opens a submenu with the items Program and Registers. 

 

Delete program 

Transmission / Delete / Program deletes single programs in the connected controller.  
MiniLog-Comm shows a selection list with all programs in the controller memory.  

Before the program is really deleted, MiniLog-Comm requires OK . The program is 

aborted with  . 

 

Important for controller MCC: 
MiniLog-Comm receives all programs and deletes the whole controller memory. The 
programs still required are transmitted to the MCC again. Please avoid to power off the 
controller or to disconnect the cable during transmission. Danger of data loss! 

 

Delete registers 

Transmission / Delete / Registers sets all registers in the controller to zero.  
MiniLog-Comm asks for acknowledge before deletion.  

 

Delete Megacard 

Transmission / Delete / Megacard deletes programs, parameter set and register set or 
all files on the ‚Megacard‘ of controller IXEα. 

Attention: ‚All‘ will take about 4 minutes! 

 

 
Deleted programs or registers can’t be recovered! 
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5.6.4 Direct Mode 

Transmission / Direct Mode opens a dialog box which allows to send instructions directly 
to the stepper motor controller. MiniLog-Comm automatically generates the complete 
protocol. 

Select first the input box to send a instruction to the controller. Now enter the MINILOG 
instruction, e.g. XP14R, which means: read parameter 14 from axis X,  
see Fig. 14: 

 

Fig. 14: Direct mode 

The instruction is sent to the controller by pressing the [ENTER]-key. 

The controller answer is shown in the response box, e.g. <ACK> 4000: the value of the 
parameter 5 of axis X is 4000. 

A history list of used instructions can be opened by the DropDown key [9].  

 

Remark: 

Phytron controller’s answer a <NAK> if an invalid instruction is used. 

Nearly all MiniLog instructions can be written without consideration of the capital and small 
letters. The button abc --> ABC  shifts the instruction. 

 

Important:  
In case of or-logic operations (e. g. Ev011) and d0 or d1 display instructions click on  
button Abc --> Abc to keep the capital and small letters. 
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5.6.5 Operation 

Transmission / Operation opens the window to move the motor directly by mouse click: 

 

Fig. 15: Operation 

Simply click on  to . Direction + means clockwise movement, seen onto 
the motor axis from outside.  

Drive instructions for both axes can be entered in Go…..  
The symbol + or – before the entered number of steps defines the direction.  
Go Relative: move from the actual position by x-counter values. 
Go Absolute: the input counter value is referred to the zero point.    

The instruction will be executed by click on Start . The movement is stopped by  

! STOP !  if required. 

The drive frequencies of both motors can be changed by two slider controls at the bottom 
of the window. The frequency can be set from 1 to 40000 Hz in 100 Hz steps. 

Each axis can be initialized by to  and stopped by ! STOP ! .  

The connected axes are displayed in Exist. Axes. Up to 2 axes can be selected to 
move. 
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In Exist. Axes you can implement a so-called "electrical wave" by the „LEDS“ among 
the existing axes selection. This means that two or more axes can be driven quasi parallel 
by clicking on  or by an input of a range.   

In fig.15 you can see the link of axes 1 with 3 and 2 with 4 as an example. Naturally three 
and more axes can be interconnected with one another, too. 

Function: 

First, the axes which are to run with one another must be selected by clicking on the 
respective LEDs of the axes. Simple click marks green, double click yellow.  

All green and all yellow axes drive together, i.e. by clicking on   the axes drive into 
positive direction. 

By clicking on    the axes 3 and 4 drive into positive direction. 

By clicking on the LEDs again the allocation is canceled, the LEDs now are grey. 
 

5.6.6 IO-Monitor 

Transmission / IO Monitor tests the inputs and outputs. IO-Monitor differs between the 
controllers MCC and OMC/TMC:  

 

Fig. 16: IO-Monitor for MCC 
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Fig. 17: IO-Monitor for OMC/TMC and IXEα 
 
Input status shows the controller’s inputs: 

LED green Input activated 

LED grey Input deactivated 

 

Output status shows the energized controller’s outputs: 

LED yellow Output energized 

LED grey Output reset 

The output state can be changed by click on one of the output LED.  

 

Device status shows the controller’s state:  

• Program execution (Local): The controller executes a saved program. Either the 
controller is in Local mode or the program is started by an interface instruction.   

• Software Remote: The controller has been set to the Remote mode by the instruction 
"IFR". The controller should be changed by the instruction "IFR" to operate the program 
start by the Remote/Local switch.  
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• Emergency stop limit switch of an axis: The limit switch of an axis is activated. You 
can get more information about activated limit switches in the IO-Monitor menu 
(Initiator status) (see chap. 5.6.7).  

• Power stage error of an axis: The power stage of an axis has got an error, which can 
be e.g. over temperature, phase short circuit, under or over voltage.  

• Programming error: An entered instruction was inoperative. The error can be reset by 
click on Reset .  

• Enable active (Power stage activated): The controller’s Enable input is wired, the 
power stages are activated.  

• Input query active: The controller is in program flow and waits for an input. Instruction 
in program e.g.: E01S  

• PC mode(Remote): The controller is in PC mode (switch setting Remote). The 
controller can be in PC mode at the same time and anyway, the status ‚Program 
execution’ can be set. In this case the program has been started by the interface.  
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Initiator status shows the state on the controller’s limit switch inputs: 

LED green Initiator is not activated 

LED red Initiator is activated 

 

Encoder counter shows the parameter 22 (count parameter of the encoder input).   

 

A/D Converter displays the state of the controller’s A/D converter inputs. The display 
can be changed between increments (0 –1023, 10Bit A/D converter) or Volt (the voltage of 
the A/D converter input).  

 

Selection selects an approximate range of the inputs or outputs, which depends on the 
number of connected device addresses. 

Controller software version shows the software version of the controller. 

Existing Axes displays the number of axes connected to the controller. 

 

 

5.6.7 Status Monitor (for OMC/TMC and MCC) 

 

Fig. 18: Status monitor 
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General Status describes the general controller states. Advanced Status displays 
other controller states of the corresponding axis (axis 1 to 8).  

Auto start program name shows the program name, which starts automatically after 
change-over the Local/Remote switch. The program name is stored in auto start of the 
controller by Set!.  
 

Colour State of the inputs Initiator status 

 not active or not available Initiator not available 

 active or OK Initiator free 

                ------------------- Initiator activated 

Remark:  Only these I/O groups, which are supplied, are detected by  
MiniLog-Comm! 

 

5.6.8 Show Position 

Transmission / Show Position opens a window where the current X-Y position of the 
figure (yellow line) is displayed: 

 

Fig. 19: Show Position 
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Function of the buttons: 

 

 The X axis is divided into grid points with the specified value. 

 
Usually the divisor of the Y axis is computed as ½ X  
(see also Fig.19).  
Other conversion factors can also be specified by hand. 

 
The changes entered at divisor X are accepted and shown. 

 

Indicates the period the position is read in. 
The smaller the update-time the more detailed is the screen 
display. 

 Deletes the screen display! 

 
The window is closed. 
If the graphic has been changed, you are asked for saving. 

 

 



Manual MiniLog-Comm 
 

 
MA 1237-A007 GB 38   

5.7 The Controller  Menu 

5.7.1 Autostart Program  

Controller/Autostart Program displays a list of programs stored in the controller. A 
program for the auto start register is selected by mouse click, which is started auto-
matically in the LOCAL mode. 

 

 

5.7.2 Search Controller 

Search Controller searches the connected controller. The COM port which is set in the 
interface parameters is scaned in all addresses and adjustable baud rates. If a controller is 
found, the COM port, baud rate and version are displayed. If no controller is found, an 
error message follows. A progress bar informs about the search progress. The search can 

be interrupted by . 

 

 

5.7.3 Current Settings (for OMC/TMC and MCC) 

Controller/Current Settings sets some axis parameter values like stop current, run 
current and boost current of the selected axis.  
  

 

Fig. 20: Power stage settings  
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Axis X, Axis Y changes between the two existing axes. 

Step resolution and run current delay time can be selected in the Drop-down bar.  

The dialog accesses the controller parameters. Changes can be received and saved by a 
parameter editor. 

Important: Please check the motor plate for the current setting! 

 

 

5.7.4 Reset (for OMC/TMC and MCC) 

Reset resets the controller.  

Attention: This menu item has the same function as Reset push-button on the controller. 
Running programs are interrupted and all outputs are reset.  

If the controller is in Local mode, the program starts in line 1, which is entered in the auto 
start register.  

 

5.7.5 Firmware Information 

This submenu reads the firmware version of the controller and displays it. 

 

5.7.6 Firmware Update (for OMC/TMC and MCC) 

This dialog is only available, if no other window is open. The Controller/ Firmware 
Update menu makes is possible to update the firmware in the controller.  

Important: There are different firmware files for the controllers OMC/TMC or MCC. The 
update of a wrong file makes the controller inoperable! Please check the right selected 
files before the update. 

Important: Save all controller files like programs, parameters and registers before the 
update.  

 

The Control lamp shows the state of update: 

Control 
lamp 

Display Status 

 ??? no action 

 deleted Firmware or system deleted 

 OK! Successful firmware update 

 Error Error during update 
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The update of a wrong file makes the controller inoperable! 

 
Firmware Update MCC 

 

Fig. 21: Firmware update MCC menu 

 

Load Indexer:  
The controller MCC offers the possibility to update both the indexer and the system of the 
controller. There are two different files:  IndexerVX.hex for indexer and 
MCC_System_VX.hex for system files. 

Click on 
Delete and load

indexer 1&2  to load the indexer firmware. A dialog is opened to select the 

file for loading. Select the IndexerVX.hex and acknowledge by OK . First, the software on 
the controller is deleted. After that, you are asked to press the Reset push-button on the 
controller.  

Important: Acknowledge this message only after the reset push-button has been pressed! 
After that the upload of the new firmware starts. The update takes a few minutes, a 
progress bar informs about the actual state. 

Click on  Delete 1. and on Load 1. to delete and update the indexer firmware for axis 1, 

click on Delete 2.  and on Load 2. to delete and update for axis 2.   
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Firmware Update OMC/TMC 
The BIOS of the controller OMC/TMC can be updated.  

Important: After the update the system is deleted on the controller. Please make sure that 
a system file exists for the controller which has to be loaded after the BIOS update. 

Important: The BIOS file can only be loaded via interface X9 on the controller. 

 

 

Fig. 22: Firmware update OMC/TMC menu 

 

Before the new BIOS file can be loaded to the controller, the controller processor must be 
switched to the Loader Mode.  

 

The following order should be observed: 

 

Fig. 23: The OMC/TMC push-buttons 
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• First press and keep push-button 2 above the interface X9.  

• Then press and release the reset push-button (above the R/L switch).  

• Only now release push-button 2.  

• Afterwards press Delete BIOS and load . The dialog for file selection opens. 

• Select the new BIOS file to transmit to the controller.  
Important: The update of a wrong firmware file makes the controller inoperable! 
However, the right BIOS file can be reloaded anytime.  

• The control lamps show the update progress: ‚Urloader’, ‚Bootstraploader’, ‚BIOS file’, 
‚Transmission complete’ shine one after another.  A progress bar informs about the 
BIOS file transmission. If all control lamps shine green, the update is successfully 
finished. If one of the control lamps shines red, the upload has failed. In this case 
repeat the steps above after a file and interface cable check.  

• Continue the update after a successful BIOS update by Load System.  

 

Load System allows to delete and load the system software of the controller. The 
system update procedure is like the indexer or BIOS update. After click on  
Delete system and load   the firmware file can be selected. Then the controller upload 
begins. A progress bar informs about the actual state.  

Important: Please avoid to power off the controller or to disconnect the cable during the 
controller update. Danger of data loss! 

 

5.7.7 Password 

In this submenu a password protection for the controller access can be set: 

• : Enable controller bei initialization without a password input or with the 
password already definded 

• Select program, parameter or register by and   . 

• Set/change password by password input and clicking on  . 

• :   Delete the password. 

Control 
lamp 

   

Controller disabled Access enabled with 
correct password  

Access refused, 
because no or a 
wrong password was 
entered. 
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The password protection is activated by a RESET or a controller’s switching on/off. 

 

 

 

 

Fig. 24: Initial state  Fig. 25: Password enabled 

 

5.8 The Execute Menu (for OMC/TMC and MCC) 

The Execute menu helps for tests of the controller's program flow step by step. 

The controller's program is started by Start  and runs until it is stopped by Stop . 
The program begins at the beginning by Start . 

The controller's program runs instruction by instruction by Single step . The controller's 
program can be stopped during run by Pause  and continues running by Start at the 
stop position. 

The program run is finished by Stop . 

 

 Start the single step mode for controller's program 

 Start the controller's program  

 Interrupt the controller's program 

 Stop the controller's program  

 Monitoring: Query of variables in a controller’s program 
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Debug (Read Variables) 

MiniLog variables are monitored and displayed during program run by Monitoring .  

 

Fig. 26: Defined variables for program flow 

Periodic (250 ms): The defined variables are read every 250 ms. 

Breakpoint/Pause: The variables are read out at the breakpoints or in the single step 
mode. 

 

Break point setting 
10 break points can be set to interrupt the controller's program in defined lines. This break 
point is set by click on the program line number with the mouse. The line number is 
marked red.  

 

Fig. 27: Break points in lines 106, 111, 115, 118 (only available in German) 
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5.9 The Options Menu 

Important: The Options menu is only available, if no window is open. 

 

5.9.1 Interface Parameters 

RS232 / RS485 

Several interface parameters can be set in this submenu. 

 

Fig. 28: Interface parameter settings 

Active COM 

The interface is set the controller is connected to.  
MiniLog-Comm searches automatically for available PC interfaces (up to 256).  
Installed  USB --> RS converter interfaces are also found und displayed. 
 

Baud rate / Checksum 
The Baud rate (data volume per second in KBits) can be selected by click the drop down 
arrow of the Baud rate box (values from 9600 to 115200). The value must be compatible 
to the controller’s baud rate. 

Remark: We recommend to search the controller via the function Search controller, if 
you don’t know the preset baud rate of the controller.  
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Checksum: (for OMC/TMC and MCC controllers):  

Checksum ON: the transmission telegram is monitored with checksum by the controller. 
Checksum OFF: the transmission telegram is sent without checksum by the controller. 

 
Transmission format 
The transmission format of the interface is set. 

Important: These settings must not be changed! They are designed for additional 
controllers. 

 

Update interval 
Update interval is set for the IO-Monitor, Operation mode and all other menus, which poll 
cyclic data via the interface. Lower baud rates enable slow intervals. If many dialogs are 
open at the same time, we recommend increasing this time. 

The changes are accepted by  and the interface is initialized with new parameters. 

  aborts without changes.  

  opens the advanced interface dialog. (Fig. 28) 

 
Change of the Controller’s Baud rate 

The baud rate of the controller can be changed in Advanced >> . The actual baud rate 
is read in Actual Baud rate.  
 

In New Baud rate a new baud rate is selected for the controller by Drop-Down. The new 
baud rate is set in the controller by click on Set! and the baud rate of the PC is set to the 
new baud rate. This function requires communication to the controller. Therefore, the baud 
rate and the COM port should be set correctly.  
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 Eth-ComSrv 

This submenu is useful for remote maintenance in the company network by connecting to 
the receiver with the receiver’s IP address. 

First,  in Options / Server (see chap. 5.9.4) the receiver’s IP address must be identified. 

 

 

Fig. 29: Connection to the server in the company’s network 

:  Connection to the receiver’s IP address. The port number is written in the 
controller’s manual. 

 : The device is online. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Manual MiniLog-Comm 
 

 
MA 1237-A007 GB 48   

Eth-MCCe 

A connection to a MCC controller via Ethernet interface:  

 

Fig. 30: Connection to the MCC controller 

 

i 
The controller refers its IP address either dynamically over DHCP 
or in a static way. 

 

: The IP address of the controller is searched only in the same subnet. 
This functions only, if the controller obtained a valid IP address over DHCP. 

: Installation of the controller’s IP address by MAC- and IP address input. 

: Allocate the input IP address. 

• You’ll find the controller’s MAC address on its type plate. Enter the MAC 
address in the appropriate input field. 
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•  If the PC is logged-in to more than one network interface card: Select that IP 
address from the displayed list to which network interface card the controller is 
connected. 

• Enter a new IP address in the input field.  

• Setting of the entered IP address by clicking on . 
 

: Delete the IP address and reset the controller to the DHCP 
mode. 

 

: Connection to the controller via selected IP address. You’ll find the port 
number in the controller’s manual. 

: The device is online, which is shown in the status bar line. 

 

 

5.9.2 Controller Type 

Options / Controller type selects the type of the connected controller. The MCC, 
OMC/TMC and IXEα (IXE Alpha) controller types are available. The MiniLog-Comm 
software is continually adapted to new phytron controller types, which are also 
programmed in MiniLog language.  

 

5.9.3 Language 

Options / Language  selects the output of the program dialog in German or English. 
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5.9.4 Server 

Options / Server integrates the controller into the customer’s network by Ethernet.  
Thereby a data exchange is possible in form of TCP/IP network protocols between all 
devices in a local network. 

The controller's data can be accessed by coworkers, who logged-on with the correct IP 
address, for telemaintenance.   

How to do: 

• PC-1 with connected controller: Com Server at IP Address: the IP address of  PC-1 is 
read. 

• The readiness for data receive is enabled by click on  . Keep the 
window open. 

 

Fig. 31: Example: read data on PC-1 

• Enter the IP address of PC-1 and the port number on PC-2 in  
Interface parameters/Ethernet at Connect to IP address. PC-1 and PC-2  
are connected by click on  . 

 

Fig. 32: Example: data enter from PC-1 to PC-2 

• Then the PC-2 can set the controller by Transmission/... menus. 

 

Important: The server (PC-1) must be connected to the controller! Danger of data loss! 
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5.10 The Windows Menu 

Windows menu arranges optically the displayed axis windows. The directories of all files 
are listed after click on Windows. The active window is selected on screen by mouse 
click. The displayed open window is marked by . 

 

5.10.1 Cascading Windows 

Several open axes files are arranged in a cascading mode by click on Cascading.  

 

Fig. 33: Before 

 

 

Fig. 34: Afterwards 
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5.10.2 Tile Windows 

The open axes files are placed horizontally by click on Tile Windows: 

 

Fig. 35:  Window: side by side 

 

5.10.3 Place Symbols 

The downsized program windows on the lower screen edge are placed in a row side by 
side. 

 

Fig. 36: Window: place symbols 
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5.10.4 Save/Load Position 

The order of the open menu windows (only Direct mode, Operation, IO Monitor, Status 
monitor and Show position) is saved by click on Save window position. 

With Load window position the saved order is displayed on the desktop. 

 

5.11 The Help Menu 

5.11.1 About MiniLog-Comm 

Options / About MiniLog-Comm gives important information about the program version 
of MiniLog-Comm, copyright and phytron’s firm data (fig. 35). 

 

Fig. 37: Information about MiniLog-Comm 

 

 

5.11.2 Help 

Options / Help menu opens the help function of MiniLog-Comm. 
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6 Error Messages 

In this appendix you will find hints how to handle error messages of MiniLog-Comm.  
Messages are not contained in this appendix, which do not need any additional 
information. 

Remark: 
Error messages related to problems with any peripheral device are very often caused by 
trivial facts like: device is not switched on, cables are missing, cable is defect, etc. 
Please check these items.  

 

Interface Problems 
An interface timeout has occured 

Possible reasons for this problem may be: 

• The cabling is wrong (RD and TD pins interchanged). 

• The controller is not in the REMOTE operation mode (Switch Remote/Local). 

• The cabling is defect or interrupted. 

• The timeout time selected in MiniLog-Comm is too short. 

• The interface parameters selected in MiniLog-Comm do not match the  
 controller type used. 

• No controller connected 

 

COM Interface already open 

Possible reason for this problem may be: 

• The COM interface is already used by another program. 
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7 Copyright and Limitation of Warranty 

The software MiniLog-Comm and any documentation delivered with it are protected by 
copyright law. The manual must not be copied, reproduced, put into machine readable 
form, neither complete or in parts, without the prior written permission of the  
Phytron GmbH. 

MiniLog-Comm as a freeware product will only give you the right to make backup copies 
for personal use. However, the program must not be changed neither be sold. 
 
 

Limitation of warranty 

The software MiniLog-Comm and its documentation have been made with great 
carefulness and have been reproduced under effective controlling measures. Nevertheless 
there might be mistakes.  

We refer to our delivery and payment conditions, in particular to item VII liability and item 
IX software utilization. 

You’ll agree to our delivery and payment conditions, if you install, copy or use otherwise 
the software. If you disagree to these conditions you aren’t authorized to install or use the 
software. 
 
 

Trade marks 

In this manual several trade marks are used which are no longer explicitly marked as trade 
marks within the text. The lack of this signs may not be used to draw the conclusion that 
these products are free of rights of third parties. Some product names used herein are for 
instance 

• Microsoft is a registered trade mark and WINDOWS is a trade mark of the 
 Microsoft Corporation in the USA and other countries. 

• MiniLog-Comm is a trade mark of the Phytron GmbH. 
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